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Your Office Microsoft 2010 Vol 1, 2e (Kinser) 

Microsoft Word 2010, Workshop 1: Reviewing and Modifying a Document 

 

1) Documents of all types are created using ________ software. 

A) word processing 

B) multimedia 

C) documentation 

D) writing 

Answer:  A 

Diff: 1 

Ref:  Using Word Processing Software 

 

2) In a Word document, along with the text, you can also have other elements such as ________. 

A) graphics, music, and videos 

B) graphics, tables, and charts 

C) charts, videos, and page borders 

D) music, videos, and page borders 

Answer:  B 

Diff: 1 

Ref:  Using Word Processing Software 

 

3) When you begin working with Microsoft Word, a(n) ________ document will open. 

A) template 

B) blank 

C) empty 

D) starter 

Answer:  B 

Diff: 1 

Ref:  Opening a Document 

 

4) Since Word documents can be filed away or circulated for a long time, you should be very 

careful when composing ________. 

A) letters, memos, and e-mail 

B) letters, memos, and artwork 

C) letters and audio content 

D) memos, graphics, and e-mail 

Answer:  A 

Diff: 1 

Ref:  Developing Effective Business Documents 
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5) Sarah has created a newsletter in Word for her boss. He wants the newsletter distributed right 

away. Sarah should ________ 

A) review the newsletter once and hope she found all the errors 

B) review the newsletter several times to ensure there are no errors 

C) skip reviewing the newsletter for errors so that it is sent as soon as possible 

D) run spelling checker and let Word find the errors 

Answer:  B 

Diff: 2 

Ref:  Developing Effective Business Documents 

6) Two forms of written business communication are ________. 

A) inside communication and outside communication 

B) public communication and private communication 

C) internal communication and external communication 

D) customer communication and employee communication 

Answer:  C 

Diff: 1 

Ref:  Developing Effective Business Documents 

 

7) Letters, memos, resumes, newsletters, flyers, and reports are types of ________. 

A) external communication 

B) internal communication 

C) business correspondence 

D) customer communication 

Answer:  C 

Diff: 1 

Ref:  Working with Business Correspondence 

 

8) A document that is meant only for internal distribution is called a(n) ________. 

A) e-mail 

B) newsletter 

C) internal communication 

D) memorandum 

Answer:  D 

Diff: 1 

Ref:  Working with Business Correspondence 

 

9) A letter style that has the entire letter left-aligned and single-spaced, with double-spacing 

between paragraphs is the ________ style. 

A) semiblock 

B) modified block 

C) block 

D) modern 

Answer:  C 

Diff: 1 

Ref:  Working with Business Correspondence 
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10) When you get to the end of a line, Word automatically moves the text to the next line using a 

feature called ________. 

A) line continuation 

B) word wrap 

C) word continuation 

D) paragraph wrap 

Answer:  B 

Diff: 1 

Ref:  Working with Business Correspondence 

11) Pressing Alt on the keyboard will display ________. 

A) pointers 

B) key tips 

C) reminders 

D) textboxes 

Answer:  B 

Diff: 1 

Ref:  Working with Business Correspondence 

 

12) In Word, a hard return occurs when you press the ________ key. 

A) Windows 

B) Ctrl 

C) Enter 

D) Alt 

Answer:  C 

Diff: 1 

Ref:  Working with Business Correspondence 

 

13) The default view in Word is the ________ view. 

A) Reading 

B) Draft 

C) Outline 

D) Print Layout 

Answer:  D 

Diff: 1 

Ref:  Working with Business Correspondence 

 

14) A(n) ________ setting is the one that is automatically used unless you specify otherwise. 

A) original 

B) beginning 

C) template 

D) default 

Answer:  D 

Diff: 1 

Ref:  Working with Business Correspondence 
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15) A view that is sometimes used as the starting point for a table of contents or PowerPoint 

summary is called the ________ view. 

A) Draft 

B) Web Layout 

C) Print Layout 

D) Outline 

Answer:  D 

Diff: 1 

Ref:  Working with Business Correspondence 

16) Anytime you press the Spacebar, Enter, or Tab, a(n) ________ is inserted into the document. 

A) notation 

B) blank space 

C) arrow 

D) nonprinting character 

Answer:  D 

Diff: 1 

Ref:  Working with Business Correspondence 

 

17) Another term for nonprinting characters is ________. 

A) formatting marks 

B) invisible marks 

C) editing marks 

D) formatting insertions 

Answer:  A 

Diff: 1 

Ref:  Working with Business Correspondence 

 

18) To exit the Full Screen Reading View, you must ________. 

A) press Ctrl + Esc 

B) click Close 

C) press Esc 

D) either B or C 

Answer:  D 

Diff: 1 

Ref:  Working with Business Correspondence 

 

19) A tool that makes setting measurements for tabs and indents easier is the ________. 

A) tab dialog box 

B) ruler dialog box 

C) table dialog box 

D) ruler 

Answer:  D 

Diff: 1 

Ref:  Working with Business Correspondence 
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20) The ________ tool makes it easier to proofread a document and locate errors, but does not 

change the text size of the document when it is printed. 

A) Zoom 

B) View 

C) Enlarge 

D) Magnify 

Answer:  A 

Diff: 1 

Ref:  Working with Business Correspondence 

21) The blinking black vertical bar that indicates where text will be placed when you type is 

called the ________. 

A) pointer 

B) insertion point 

C) cursor 

D) insertion bar 

Answer:  B 

Diff: 1 

Ref:  Working with Business Correspondence 

 

22) Sarah wants to move the insertion point to a location further down the document page. To do 

this, she must ________. 

A) use the Tab button to move to the location where she wants to type text 

B) use the vertical scrollbar to scroll down to the location where she wants to type text 

C) use the horizontal scrollbar to scroll to the location where she wants to type text 

D) click at the location where she wants to type text 

Answer:  D 

Diff: 2 

Ref:  Working with Business Correspondence 

 

23) To position the insertion point at the end of the document, press ________. 

A) Ctrl+End 

B) Alt+End 

C) Ctrl+Down 

D) Alt+Down 

Answer:  A 

Diff: 1 

Ref:  Working with Business Correspondence 

 

24) Backstage view is a collection of ________. 

A) links to articles about Microsoft Word 2010 

B) links to online help files 

C) common actions, properties, and settings related to an open file 

D) actions such as delete, save, and print 

Answer:  C 

Diff: 1 

Ref:  Working with Business Correspondence 
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25) A quick way to open recently accessed Word documents is to ________. 

A) click Recent Documents 

B) click the question mark at the top right corner of the screen 

C) click Open 

D) click the File tab to open the Backstage view 

Answer:  D 

Diff: 1 

Ref:  Working with Business Correspondence 

26) Web storage that Microsoft makes available free of charge is called ________. 

A) SkyWeb 

B) WebDrive 

C) SkyDrive 

D) OnlineDrive 

Answer:  C 

Diff: 1 

Ref:  Saving and Closing a Document 

 

27) To access SkyDrive from within a browser, you must visit ________ and sign in with your 

ID and password. 

A) skydrive.live.com 

B) microsoft.live.com 

C) microsoft.skydrive.com 

D) skydrive.microsoft.com 

Answer:  A 

Diff: 1 

Ref:  Saving and Closing a Document 

 

28) ________ is a new feature in the Office 2010 release that lets you store files on the web and 

open them in web versions of Word, PowerPoint, or Excel. 

A) Online applications 

B) WebDrive 

C) Web Apps 

D) Online Apps 

Answer:  C 

Diff: 1 

Ref:  Saving and Closing a Document 

 

29) When files are saved to SkyDrive, you can access them from ________. 

A) any computer that has web Apps installed 

B) any computer with Internet access 

C) any computer with Microsoft Office 2010 installed 

D) any computer that has any version of Microsoft Office installed 

Answer:  B 

Diff: 2 

Ref:  Saving and Closing a Document 
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30) Saving a Word document as a(n) ________ file type helps prevent the spread of viruses. 

A) DOC 

B) txt 

C) PDF (Portable Document Format) 

D) RTF (Rich Text Format) 

Answer:  C 

Diff: 1 

Ref:  Saving and Closing a Document 

31) To read a PDF file, you must download and install ________. 

A) Adobe Reader 

B) Adobe Writer 

C) PDF Reader/Writer 

D) PDF Reader 

Answer:  A 

Diff: 1 

Ref:  Saving and Closing a Document 

 

32) Unless you have made changes to the default, Word shows ________ recently opened files in 

the Recent Documents List. 

A) 20 

B) 35 

C) 40 

D) 25 

Answer:  A 

Diff: 1 

Ref:  Saving and Closing a Document 

 

33) To apply changes to existing text, you must first ________. 

A) save the document 

B) select the existing text 

C) select the document 

D) delete the existing text 

Answer:  B 

Diff: 1 

Ref:  Editing a Document 

 

34) To select an entire document, you ________. 

A) triple-click anywhere on the page 

B) press Ctrl+A 

C) press Shift+Alt 

D) press and hold Ctrl while dragging the mouse 

Answer:  B 

Diff: 1 

Ref:  Editing a Document 
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35) A character design that includes such qualities as typeface, size, and spacing is called a 

________. 

A) font 

B) style 

C) theme 

D) character 

Answer:  A 

Diff: 1 

Ref:  Editing a Document 

36) Mary asked Sarah which font would be best for a long newsletter. Sarah told her to use a 

________, because it makes large amounts of printed text easy to read. 

A) large font 

B) newspaper font 

C) sans serif font 

D) serif font 

Answer:  D 

Diff: 2 

Ref:  Editing a Document 

 

37) A style of printed characters is called a(n) ________. 

A) font 

B) typeface 

C) character style 

D) alphabet 

Answer:  B 

Diff: 1 

Ref:  Editing a Document 

 

38) Font size is measured in ________. 

A) inches 

B) centimeters 

C) points 

D) picas 

Answer:  C 

Diff: 1 

Ref:  Editing a Document 

 

39) Text enhancements such as adding a shadow, outline, reflection, or glow are accomplished 

using ________. 

A) text embellishments 

B) TextArt 

C) WordArt 

D) text effects 

Answer:  D 

Diff: 1 

Ref:  Editing a Document 
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40) To print a document you use ________. 

A) Backstage view 

B) Printer view 

C) Alt+P 

D) Print view 

Answer:  A 

Diff: 1 

Ref:  Printing a Document 

 

41) Creating a document that contains grammatical or factual errors and misspellings may lead 

others to consider you careless or noncredible. 

Answer:  TRUE 

Diff: 1 

Ref:  Developing Effective Business Documents 

42) Effective internal communications can increase productivity, because employees are more 

likely to understand and support the goals and objectives of the company. 

Answer:  TRUE 

Diff: 2 

Ref:  Developing Effective Business Documents 

 

43) Memorandums are intended to provide information to customers. 

Answer:  FALSE 

Diff: 1 

Ref:  Working with Business Correspondence 

 

44) Letter styles that are acceptable in business letters include the block, modified block and 

semiblock styles. 

Answer:  TRUE 

Diff: 1 

Ref:  Working with Business Correspondence 

 

45) You should press Enter at the end of every sentence so that Word will know the sentence is 

complete. 

Answer:  FALSE 

Diff: 1 

Ref:  Working with Business Correspondence 

 

46) By displaying the nonprinting characters, you can troubleshoot a document to remove 

unnecessary tabs and spaces. 

Answer:  TRUE 

Diff: 1 

Ref:  Working with Business Correspondence 
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47) Both the Ribbon and the status bar are available in the Full Screen Reading view. 

Answer:  FALSE 

Diff: 1 

Ref:  Working with Business Correspondence 

 

48) Using Zoom is not advised because it will make the document print incorrectly if you forget 

to turn it off. 

Answer:  FALSE 

Diff: 1 

Ref:  Working with Business Correspondence 

 

49) Dragging the vertical scroll bar repositions the insertion point to the end of the displayed 

text. 

Answer:  FALSE 

Diff: 1 

Ref:  Working with Business Correspondence 

 

50) To customize the Ribbon, change the default location where files are saved, or specify 

different privacy settings, you must use Word Options. 

Answer:  TRUE 

Diff: 1 

Ref:  Working with Business Correspondence 

51) It is unnecessary to save your work because Word will do it for you. 

Answer:  FALSE 

Diff: 1 

Ref:  Saving and Closing a Document 

 

52) Before you can use SkyDrive, you must first register at skydrive.live.com. 

Answer:  TRUE 

Diff: 1 

Ref:  Saving and Closing a Document 

 

53) When you need to transmit a Word document in a compatible and secure format, you should 

always save the document as a txt file. 

Answer:  FALSE 

Diff: 1 

Ref:  Saving and Closing a Document 

 

54) Preview Now is a feature that provides a look at the result of a selection before you actually 

make the choice. 

Answer:  FALSE 

Diff: 1 

Ref:  Editing a Document 
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55) A sans serif font is useful for titles, logos, and headings, while a serif font is better for 

documents with large amounts of text such as newsletters and reports. 

Answer:  TRUE 

Diff: 2 

Ref:  Editing a Document 

 

56) Font spacing is either monospaced or proportional. 

Answer:  TRUE 

Diff: 1 

Ref:  Editing a Document 

 

57) Sarah wants to create a document with text that measures one inch; to do this, she should set 

her text to 72 points. 

Answer:  TRUE 

Diff: 3 

Ref:  Editing a Document 

 

58) The accepted font standard for business documents is Times New Roman 12 pt. 

Answer:  TRUE 

Diff: 1 

Ref:  Editing a Document 

 

59) When a document is justified, the text is aligned on the right with a ragged left edge. 

Answer:  FALSE 

Diff: 1 

Ref:  Editing a Document 

60) By default, new Word documents are left-aligned. 

Answer:  TRUE 

Diff: 1 

Ref:  Editing a Document 

 

61) Word underlines misspelled words in green, grammatical errors in blue, and word-usage 

errors in red. 

Answer:  FALSE 

Diff: 1 

Ref:  Editing a Document 

 

62) AutoCorrect corrects common misspellings ONLY AFTER you configure it in the Options 

section of the File tab. 

Answer:  FALSE 

Diff: 1 

Ref:  Editing a Document 
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63) When you place a page number in a header or footer, Word automatically increments the 

numbers to ensure that all pages are numbered correctly. 

Answer:  TRUE 

Diff: 1 

Ref:  Editing a Document 

 

64) To undelete or retrieve deleted text, you can use the Undo button on the Quick Access 

Toolbar. 

Answer:  TRUE 

Diff: 1 

Ref:  Editing a Document 

 

65) Backstage view displays a preview of a document when you click the File tab. 

Answer:  FALSE 

Diff: 1 

Ref:  Printing a Document 

 

66) Letters, memos, resumes, applications, flyers, ________, and brochures are types of business 

correspondence. 

Answer:  reports 

Diff: 1 

Ref:  Developing Effective Business Documents 

 

67) The format of a(n) ________ is much less prescriptive than a business letter. 

Answer:  memorandum 

Diff: 1 

Ref:  Working with Business Correspondence 

 

68) The ________, or letterhead, of a letter includes the writer's address and the date of the letter. 

Answer:  heading 

Diff: 1 

Ref:  Working with Business Correspondence 

69) The feature with which Word automatically wraps text from one line to the next is called 

________. 

Answer:  word wrap 

Diff: 1 

Ref:  Working with Business Correspondence 

 

70) Nonprinting characters are also known as ________. 

Answer:  formatting marks 

Diff: 1 

Ref:  Working with Business Correspondence 
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71) The ________ feature allows you to increase the size of text on the screen, but does NOT 

change the text size of a document when it is printed. 

Answer:  Zoom 

Diff: 1 

Ref:  Working with Business Correspondence 

 

72) The ________ is a blinking black bar that shows where the text you type will be placed in 

the document. 

Answer:  insertion point 

Diff: 1 

Ref:  Working with Business Correspondence 

 

73) The ________ provides a quick way to open recently accessed files, save files to a disk 

drive, or share files online. 

Answer:  Backstage view 

Diff: 1 

Ref:  Working with Business Correspondence 

 

74) You should ________ your document often so you will not have to do a great deal of rework 

if you have a power outage. 

Answer:  save 

Diff: 1 

Ref:  Saving and Closing a Document 

 

75) When creating passwords for online activities, you should use at least 14 characters, 

including both uppercase and lowercase letters and ________. 

Answer:  numbers 

Diff: 1 

Ref:  Saving and Closing a Document 

 

76) Files sent to the web from Word 2010 are saved to a(n) ________ account. 

Answer:  SkyDrive 

Diff: 1 

Ref:  Saving and Closing a Document 

 

77) The only software required to open a PDF document is ________. 

Answer:  Adobe Reader 

Diff: 1 

Ref:  Saving and Closing a Document 

78) To save a document again after it has been previously saved, click the File tab, and then click 

________. 

Answer:  Save As 

Diff: 2 

Ref:  Saving and Closing a Document 
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79) Before you can change existing text, you must ________ it. 

Answer:  select 

Diff: 1 

Ref:  Editing a Document 

 

80) ________ allows you to see the result of a font selection before you actually make a change 

to a different font. 

Answer:  Live Preview 

Diff: 1 

Ref:  Editing a Document 

 

81) Font size measurements are determined by points, which are ________ of an inch. 

Answer:  1/72 

Diff: 1 

Ref:  Editing a Document 

 

82) When the pointer is near a selection, a(n) ________ is revealed. 

Answer:  Mini toolbar 

Diff: 1 

Ref:  Editing a Document 

 

83) The ________ button in the Font group on the Home tab will increase the size of selected 

text. 

Answer:  Grow Font 

Diff: 1 

Ref:  Editing a Document 

 

84) Word defines a paragraph as a(n) ________. 

Answer:  hard return 

Diff: 2 

Ref:  Editing a Document 

 

85) Words that are NOT found in Word's dictionary are underlined in ________. 

Answer:  red 

Diff: 1 

Ref:  Editing a Document 

 

86) ________ automatically corrects common spelling mistakes. 

Answer:  AutoCorrect 

Diff: 1 

Ref:  Editing a Document 

 

87) A(n)________ is text or graphics printed in the top margin of a document. 

Answer:  header 

Diff: 1 

Ref:  Editing a Document 
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88) A(n) ________ inserted into a document footer automatically increments so that it is correct 

for all pages. 

Answer:  page number 

Diff: 1 

Ref:  Editing a Document 

 

89) A command that reverses itself when clicked a second time is called a(n) ________. 

Answer:  toggle 

Diff: 1 

Ref:  Editing a Document 

 

90) Portrait and landscape are the two options available in page ________. 

Answer:  orientation 

Diff: 1 

Ref:  Printing a Document 

 

91) Match the answer in the first column to the appropriate definition in the second column. 

Each answer can only be used once. 

I. End 

II. Home 

III. Ctrl+Home 

IV. Page Up 

V. Ctrl+End 

 

A. moves the insertion point to the beginning of the current line 

B. moves the insertion point to the end of the current line 

C. moves the insertion point the beginning of the document 

D. moves the insertion point up one page 

E. moves the insertion point to the end of the document 

Answer:  I. B, II. A, III. C, IV. D, V. E 

Diff: 1 

Ref:  Working with Business Correspondence 
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Your Office Microsoft 2010 Vol 1, 2e (Kinser) 

Common Features, Workshop 1: Understanding the Common Features of Microsoft Office 

 

1) Microsoft Word is a(n) ________ application. 

A) presentation 

B) spreadsheet 

C) planner and note taking 

D) word processing 

Answer:  D 

Diff: 1 

Ref:  Working with the Office Interface and the Ribbon 

 

2) Items such as pictures, clip art, SmartArt, shapes, and charts that you can add to a Word 

document are called ________. 

A) graphics 

B) photos 

C) images 

D) art 

Answer:  A 

Diff: 1 

Ref:  Working with the Office Interface and the Ribbon 

 

3) Microsoft Excel is a(n) ________ application. 

A) spreadsheet 

B) presentation 

C) database 

D) desktop publishing 

Answer:  A 

Diff: 1 

Ref:  Working with the Office Interface and the Ribbon 

 

4) Files created by Excel are called ________. 

A) workbooks 

B) databases 

C) documents 

D) worksheets 

Answer:  A 

Diff: 1 

Ref:  Working with the Office Interface and the Ribbon 
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5) Microsoft PowerPoint is a(n) ________ application. 

A) planner and note taking 

B) information management 

C) spreadsheet 

D) presentation 

Answer:  D 

Diff: 1 

Ref:  Working with the Office Interface and the Ribbon 

6) Microsoft Outlook is a(n) ________ program. 

A) information management 

B) presentation 

C) spreadsheet 

D) database 

Answer:  A 

Diff: 1 

Ref:  Working with the Office Interface and the Ribbon 

 

7) The application in the Microsoft Office suite that would be used to develop and maintain 

databases is called ________. 

A) Publisher 

B) Excel 

C) Access 

D) OneNote 

Answer:  C 

Diff: 2 

Ref:  Working with the Office Interface and the Ribbon 

 

8) Judy needs to create brochures, newsletters and postcards for her home business. She should 

use the Microsoft ________ program. 

A) Excel 

B) PowerPoint 

C) Outlook 

D) Publisher 

Answer:  D 

Diff: 2 

Ref:  Working with the Office Interface and the Ribbon 

 

9) A(n) ________ displays when you move your mouse pointer over an icon in the taskbar. 

A) message box 

B) document 

C) dialog box 

D) thumbnail 

Answer:  D 

Diff: 1 

Ref:  Starting and Exploring Office Programs and Common Window Elements 
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10) In Word, the ________ view shows how the document appears as a web page. 

A) Print Layout 

B) Browser Layout 

C) Outline layout 

D) Web Layout 

Answer:  D 

Diff: 2 

Ref:  Starting and Exploring Office Programs and Common Window Elements 

11) You can quickly switch between the views in Word by using the View buttons located on the 

right side of the ________. 

A) title bar 

B) scroll bar 

C) taskbar 

D) status bar 

Answer:  D 

Diff: 1 

Ref:  Starting and Exploring Office Programs and Common Window Elements 

 

12) The two tabs all Microsoft Office applications have in common are the ________. 

A) Home tab and the Charts tab 

B) Home tab and the File tab 

C) Design tab and the File tab 

D) Insert tab and the Mailing tab 

Answer:  B 

Diff: 3 

Ref:  Using the Ribbon 

 

13) The Formulas tab is specific to the ________ application. 

A) Excel 

B) Access 

C) Publisher 

D) OneNote 

Answer:  A 

Diff: 1 

Ref:  Using the Ribbon 

 

14) The Minimize Ribbon button is a ________ button that reduces the Ribbon to a single line. 

A) checkbox 

B) radio 

C) toggle 

D) switch 

Answer:  C 

Diff: 2 

Ref:  Using the Ribbon 
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15) A(n) ________ is a set of menu options that appear when you click the More button next to a 

Ribbon button. 

A) option list 

B) gallery 

C) setup box 

D) window 

Answer:  B 

Diff: 1 

Ref:  Using the Ribbon 

16) A(n) ________ pane is a smaller window pane that sometimes appears at the side of the 

program window and offers options or helps you navigate through completing a task or feature. 

A) option 

B) task 

C) dialog 

D) information 

Answer:  B 

Diff: 1 

Ref:  Using the Ribbon 

 

17) The ________ opens a dialog box, which provides more options or settings beyond those 

provided on the Ribbon. 

A) Dialog Pane 

B) TaskBar 

C) Dialog Box Launcher 

D) Task Pane 

Answer:  C 

Diff: 2 

Ref:  Using the Ribbon 

 

18) ________ options allow you to select more than one option. 

A) Mini toolbar 

B) Radio button 

C) Check box 

D) Keyboard shortcut 

Answer:  C 

Diff: 1 

Ref:  Using Contextual Tools 

 

19) A ________ option allows you to select ONLY one option. 

A) Mini toolbar 

B) Check box 

C) radio button 

D) Keyboard shortcut 

Answer:  C 

Diff: 1 

Ref:  Using Contextual Tools 
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20) When text is selected, a(n) ________ appears. 

A) Mini toolbar 

B) option box 

C) dialog box 

D) contextual tab 

Answer:  A 

Diff: 1 

Ref:  Using Contextual Tools 

21) A list of commands related to a selection that appears when you right-click is called a(n) 

________. 

A) shortcut menu 

B) dialog box 

C) Mini toolbar 

D) option menu 

Answer:  A 

Diff: 1 

Ref:  Using Contextual Tools 

 

22) To close an unwanted shortcut menu or gallery menu without making a selection, press the 

________ key. 

A) Shift 

B) ESC 

C) Enter 

D) Alt 

Answer:  B 

Diff: 2 

Ref:  Using Contextual Tools 

 

23) As you work, you should save your word at least every ________. 

A) two minutes 

B) twenty minutes 

C) ten minutes 

D) thirty minutes 

Answer:  C 

Diff: 1 

Ref:  Using Contextual Tools 

 

24) Until you save your work, it is stored in the ________ memory on your computer. 

A) hard drive 

B) temporary 

C) CD drive 

D) USB flash drive 

Answer:  B 

Diff: 1 

Ref:  Working with Files 
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25) Three ways to save a file are to use the Save button on the Quick Access Toolbar, use the 

Save command on the Backstage view, and use the keyboard shortcut key ________. 

A) ESC+S 

B) Tab+S 

C) Alt+S 

D) Ctrl+S 

Answer:  D 

Diff: 1 

Ref:  Working with Files 

26) Microsoft Office file names can be up to ________ characters, including the extension and 

the number of characters in the file path. 

A) 255 

B) 50 

C) 300 

D) 25 

Answer:  A 

Diff: 1 

Ref:  Working with Files 

 

27) Special characters you can NOT use in file names are ________. 

A) ? / | < > * : ~ 

B) ? " / | < > * : 

C) ? " / | < > ; : 

D) ? " /\ | < > : 

Answer:  B 

Diff: 3 

Ref:  Working with Files 

 

28) One-click access to the most commonly used commands, such as saving a file and undoing 

recent actions is available on the ________. 

A) Task bar 

B) Ribbon 

C) Quick Access Toolbar 

D) Mini toolbar 

Answer:  C 

Diff: 1 

Ref:  Working with Files 
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29) When you open a file in ________, you must click the Enable Editing button before you can 

edit, save, or print the contents. 

A) Shield View 

B) Safeguard View 

C) Defensive View 

D) Protected View 

Answer:  D 

Diff: 1 

Ref:  Working with Files 

 

30) An online workspace provided by Microsoft is called the Windows Live ________. 

A) SkyDrive 

B) OnlineDrive 

C) Windows Drive 

D) WorkPlace 

Answer:  A 

Diff: 1 

Ref:  Sharing Files Using Windows Live SkyDrive 

31) According to the textbook, Microsoft provides ________ of free password protected online 

storage. 

A) 25 GB 

B) 250 GB 

C) 100 MB 

D) 25 MB 

Answer:  A 

Diff: 1 

Ref:  Sharing Files Using Windows Live SkyDrive 

 

32) Files saved to an online workspace can be edited by ________. 

A) only two people at the same time 

B) more than one person, but NOT at the same time 

C) more than one person at the same time 

D) only one person at a time 

Answer:  C 

Diff: 2 

Ref:  Sharing Files Using Windows Live SkyDrive 

 

33) The small window that displays descriptive text when you put the mouse pointer on an object 

or button is called a(n) ________. 

A) ContextualTip 

B) ScreenTip 

C) OptionTip 

D) HelpTip 

Answer:  B 

Diff: 1 

Ref:  Getting Help 



8 

Copyright © 2013 Pearson Education, Inc. 

 

34) In each program's ________ window, you can find step-by-step instructions for specific 

procedures. 

A) Assistance 

B) Support 

C) Help 

D) Utility 

Answer:  C 

Diff: 1 

Ref:  Getting Help 

 

35) ________ is the short cut key to access the Help window. 

A) F2 

B) F8 

C) F3 

D) F1 

Answer:  D 

Diff: 1 

Ref:  Getting Help 

36) A paper copy of a document, spreadsheet, or presentation is called a(n) ________. 

A) soft copy 

B) hard copy 

C) page copy 

D) print copy 

Answer:  B 

Diff: 1 

Ref:  Printing a File 

 

37) To avoid wasting ink and paper, you should do a ________ before printing. 

A) document view 

B) page preview 

C) page view 

D) print preview 

Answer:  D 

Diff: 1 

Ref:  Printing a File 

 

38) When you close a program, if you have made changes to the file, a dialog box opens, asking 

if you wish to ________ your changes. 

A) import 

B) discard 

C) copy 

D) save 

Answer:  D 

Diff: 1 

Ref:  Exiting Programs 
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39) When you are finished with a program, you should ________ the program to save system 

resources. 

A) remove 

B) exit 

C) minimize 

D) switch 

Answer:  B 

Diff: 1 

Ref:  Exiting Programs 

 

40) Microsoft OneNote is a program used to develop presentation slides. 

Answer:  FALSE 

Diff: 1 

Ref:  Working with the Office Interface and the Ribbon 

 

41) Access is a two-dimensional database program known as a relational database. 

Answer:  FALSE 

Diff: 3 

Ref:  Working with the Office Interface and the Ribbon 

42) Though each application in the Microsoft Office suite has common features in the user 

interface, each also has features specific to that application. 

Answer:  TRUE 

Diff: 3 

Ref:  Working with the Office Interface and the Ribbon 

 

43) You can only open ONE Microsoft application at one time. 

Answer:  FALSE 

Diff: 1 

Ref:  Starting and Exploring Office Programs and Common Window Elements 

 

44) In Word, the file you create is called a document. 

Answer:  TRUE 

Diff: 1 

Ref:  Starting and Exploring Office Programs and Common Window Elements 

 

45) In Excel, you have to add columns and rows to the document window before starting your 

spreadsheet. 

Answer:  FALSE 

Diff: 2 

Ref:  Starting and Exploring Office Programs and Common Window Elements 

 

46) In a new Excel spreadsheet, the active cell is the last cell of the first row. 

Answer:  FALSE 

Diff: 1 

Ref:  Starting and Exploring Office Programs and Common Window Elements 



10 

Copyright © 2013 Pearson Education, Inc. 

 

47) One method of switching between Windows is to use Alt+Tab. 

Answer:  TRUE 

Diff: 2 

Ref:  Starting and Exploring Office Programs and Common Window Elements 

 

48) The three buttons at the top right of each Microsoft Office application's title bar are called 

the Minimize button, the Restore Down or Maximize button, and the Open button. 

Answer:  FALSE 

Diff: 1 

Ref:  Starting and Exploring Office Programs and Common Window Elements 

 

49) The Maximize button at the far right of the application's title bar expands the window to its 

full size. 

Answer:  TRUE 

Diff: 1 

Ref:  Starting and Exploring Office Programs and Common Window Elements 

 

50) The zoom level on a Word document only affects your view of the document, not the printed 

output. 

Answer:  TRUE 

Diff: 2 

Ref:  Starting and Exploring Office Programs and Common Window Elements 

51) When the zoom level is set to 300%, vertical or horizontal scroll bars will display to make it 

possible to adjust what is displayed in the window. 

Answer:  TRUE 

Diff: 3 

Ref:  Starting and Exploring Office Programs and Common Window Elements 

 

52) Clicking any button on the Ribbon will produce an action ONLY if you are in the right 

layout view. 

Answer:  FALSE 

Diff: 2 

Ref:  Using the Ribbon 

 

53) The right mouse button provides options from which you can choose, instead of initiating or 

performing an action. 

Answer:  TRUE 

Diff: 2 

Ref:  Using the Ribbon 

 

54) Backstage view gives you access to document level features of your file. 

Answer:  FALSE 

Diff: 2 

Ref:  Using the Ribbon 
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55) An arrow next to a button in the Ribbon is an indicator that more options are available 

Answer:  TRUE 

Diff: 1 

Ref:  Using the Ribbon 

 

56) The Dialog Box Launcher opens a gallery of menu options. 

Answer:  FALSE 

Diff: 1 

Ref:  Using the Ribbon 

 

57) Unlike a radio button option, ONLY one check box option can be selected. 

Answer:  FALSE 

Diff: 1 

Ref:  Using Contextual Tools 

 

58) A Mini toolbar appears after text is selected and contains buttons for the most commonly 

used formatting commands. 

Answer:  TRUE 

Diff: 1 

Ref:  Using Contextual Tools 

 

59) A shortcut menu appears when an object or text is selected. 

Answer:  FALSE 

Diff: 1 

Ref:  Using Contextual Tools 

60) To prevent loss of work, you must save the work before exiting a program or turning off the 

computer. 

Answer:  TRUE 

Diff: 1 

Ref:  Working with Files 

 

61) File names can ONLY be 12 characters long, excluding the extension. 

Answer:  FALSE 

Diff: 1 

Ref:  Working with Files 

 

62) Windows Live SkyDrive is a free online file storage area that provides you with up to 25 GB 

of password protected storage space. 

Answer:  TRUE 

Diff: 1 

Ref:  Sharing Files Using Windows Live SkyDrive 
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63) A print preview allows you to see how a printed document will look so that you can correct 

any problems before wasting paper and ink. 

Answer:  TRUE 

Diff: 2 

Ref:  Printing a File 

 

64) To save system resources and keep your Windows desktop and taskbar uncluttered, you 

should always exit a program when you are finished using it. 

Answer:  TRUE 

Diff: 1 

Ref:  Exiting Programs 

 

65) Microsoft Office 2010 is a suite of productivity ________ or programs. 

Answer:  applications 

Diff: 2 

Ref:  Working with the Office Interface and the Ribbon 

 

66) The Microsoft Office application that is referred to as an information management program 

is ________. 

Answer:  Outlook 

Diff: 1 

Ref:  Working with the Office Interface and the Ribbon 

 

67) When you move your mouse pointer over one of the taskbar icons, a(n) ________ is 

displayed. 

Answer:  thumbnail 

Diff: 2 

Ref:  Starting and Exploring Office Programs and Common Window Elements 

 

68) If you need to see more of a documents contents, you can ________ out. 

Answer:  zoom 

Diff: 1 

Ref:  Starting and Exploring Office Programs and Common Window Elements 

69) A(n) ________ button turns on a feature if you click it once, then turns the same feature off 

if you click it a second time. 

Answer:  toggle 

Diff: 1 

Ref:  Using the Ribbon 

 

70) The options that appear on the ________ change depending on where the mouse pointer is 

located. 

Answer:  shortcut menu 

Diff: 2 

Ref:  Using the Ribbon 
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71) The feature that allows you to see how formatting looks before you apply it is called the 

________ feature. 

Answer:  Live Preview 

Diff: 1 

Ref:  Using the Ribbon 

 

72) The ________ opens a corresponding dialog box or task pane which provides more options 

or settings beyond those available in the Ribbon. 

Answer:  Dialog Box Launcher 

Diff: 1 

Ref:  Using the Ribbon 

 

73) When text is selected, a(n) ________ with the most commonly used formatting commands 

appears. 

Answer:  Mini toolbar 

Diff: 1 

Ref:  Using Contextual Tools 

 

74) A Ribbon tab that contains commands related to selected objects so that you can manipulate, 

edit and format the objects is called a(n) ________ tab. 

Answer:  contextual 

Diff: 2 

Ref:  Using Contextual Tools 

 

75) A(n) ________ is a list of commands that appears when you right-click. 

Answer:  shortcut menu 

Diff: 1 

Ref:  Using Contextual Tools 

 

76) If the computer is turned off or experiences a power failure, a feature that will attempt to 

recover your files is called the ________ feature. 

Answer:  AutoRecovery 

Diff: 1 

Ref:  Working with Files 

 

77) File names can include a maximum of ________ characters, including the extension. 

Answer:  255 

Diff: 1 

Ref:  Working with Files 

78) A file name includes the name you specify for the file and a file ________ that is assigned by 

the Office program to indicate the file type. 

Answer:  extension 

Diff: 2 

Ref:  Working with Files 
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79) Files names can include uppercase and lowercase letters, numbers, hyphens, spaces and some 

________ in any combination, except for ? " / | < > * and :. 

Answer:  special characters 

Diff: 3 

Ref:  Working with Files 

 

80) The ________ provides one-click access to commonly used commands. 

Answer:  Quick Access Toolbar 

Diff: 2 

Ref:  Working with Files 

 

81) When you open a file in ________ , you can see and read the file, but you CANNOT edit, 

save, or print the contents until you enable editing. 

Answer:  Protected view 

Diff: 2 

Ref:  Working with Files 

 

82) Using the Save & Send tab in the ________ view, you can easily e-mail a copy of your file 

to a friend. 

Answer:  Backstage 

Diff: 1 

Ref:  Sharing Files Using Windows Live SkyDrive 

 

83) The Windows Live ________ is a free online file storage area where you can save up to 25 

GB of files. 

Answer:  SkyDrive 

Diff: 2 

Ref:  Sharing Files Using Windows Live SkyDrive 

 

84) Before you can use SkyDrive, you must have a Windows Live ________. 

Answer:  ID 

Diff: 1 

Ref:  Sharing Files Using Windows Live SkyDrive 

 

85) ________ are small windows that display descriptive text when you put your mouse pointer 

on an object. 

Answer:  ScreenTips 

Diff: 1 

Ref:  Getting Help 

 

86) When you need to learn how to do a specific action in an Office application, you can open 

the ________ window to find step-by-step instructions. 

Answer:  Help 

Diff: 1 

Ref:  Getting Help 
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87) The keyboard shortcut used to access Help is the ________ key. 

Answer:  F1 

Diff: 1 

Ref:  Getting Help 

 

88) A paper copy of a document is also known as a(n) ________. 

Answer:  hard copy 

Diff: 1 

Ref:  Printing a File 
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Your Office Microsoft 2010 Vol 1, 2e (Kinser) 

Microsoft Access 2010, Workshop 1: Understanding the Four Main Database Objects 

 

1) A collection of records is a(n) ________. 

A) folder 

B) archive 

C) spreadsheet 

D) database 

Answer:  D 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

2) Facts about people, events, things, or ideas are called ________. 

A) information 

B) data 

C) lists 

D) documents 

Answer:  B 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

3) The ability to link ________ is what gives a database system its power. 

A) forms 

B) records 

C) queries 

D) tables 

Answer:  D 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

4) Data that has been manipulated to make it meaningful and useful is called ________. 

A) information 

B) a fact 

C) content 

D) a field 

Answer:  A 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

5) A database management system program developed by Microsoft is ________. 

A) Word 

B) Access 

C) Project 

D) Excel 

Answer:  B 

Diff: 1 

Ref:  Understanding Database Basics and Tables 
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6) The four main database objects in Access are ________. 

A) tables, forms, programs, and reports 

B) tables, records, programs, and reports 

C) tables, queries, forms, and reports 

D) tables, queries, programs, and reports 

Answer:  C 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

7) The database object that stores data organized in an arrangement of columns and rows is 

called a ________. 

A) field 

B) form 

C) table 

D) record 

Answer:  C 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

8) To answer questions about data in your tables, you use ________. 

A) forms 

B) spreadsheets 

C) queries 

D) reports 

Answer:  C 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

9) To produce a printed summary of the fields and records from a table or query in an easy-to-

read format you would use a ________. 

A) query 

B) report 

C) form 

D) document 

Answer:  B 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

10) The database object that holds organized data arranged in columns and rows is a ________. 

A) report 

B) form 

C) table 

D) query 

Answer:  C 

Diff: 1 

Ref:  Understanding Database Basics and Tables 
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11) A ________ contains all the data concerning one person, place, thing, or event. 

A) table 

B) query 

C) report 

D) record 

Answer:  D 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

12) The table view that shows the data contents within a table is called the ________ view. 

A) design 

B) datasheet 

C) data 

D) table 

Answer:  B 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

13) The view that shows how fields are defined is called the ________ view. 

A) datasheet 

B) design 

C) data 

D) table 

Answer:  B 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

14) Represented by a column in Access, a specific piece of information that is stored in every 

record is called a ________. 

A) field 

B) data 

C) form 

D) table 

Answer:  A 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

15) The structure of a database which includes tables, fields, forms, queries, and reports but has 

no data is a ________. 

A) beginner database 

B) sample database 

C) starter database 

D) template database 

Answer:  D 

Diff: 1 

Ref:  Understanding Database Basics and Tables 
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16) A ________ is a database that is presupplied with data. 

A) beginner database 

B) template database 

C) sample database 

D) starter database 

Answer:  C 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

17) Before you trust a file, you should first ________. 

A) run a virus scan on it 

B) repair it 

C) compress it 

D) compact it 

Answer:  A 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

18) When working with objects in your Access database, you many need to use the ________ to 

find objects. 

A) Search bar 

B) Query wizard 

C) Query box 

D) Search wizard 

Answer:  A 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

 

19) The file name suffix that helps Windows determine which program should open a file is 

called a(n) ________. 

A) file extension 

B) data expansion 

C) object extension 

D) file expansion 

Answer:  A 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

 

20) The file extension for Access files is ________. 

A) .acc 

B) .accdb 

C) .adb 

D) .acdb 

Answer:  B 

Diff: 1 

Ref:  Understanding Database Basics and Tables 
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21) Data stored and organized in an arrangement of columns and rows is called a(n) ________. 

A) table 

B) report 

C) object 

D) form 

Answer:  A 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

22) Julio will use a process called ________ to add content from an Excel worksheet to an 

Access table. 

A) inserting 

B) importing 

C) moving 

D) copying 

Answer:  B 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

 

23) A(n) ________ located at the bottom of the table allows you to move through the table. 

A) Object bar 

B) Table bar 

C) Navigation bar 

D) Content bar 

Answer:  C 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

24) A database that allows multiple connected tables is called a(n) ________. 

A) relational database 

B) joined database 

C) connected database 

D) associated database 

Answer:  A 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

25) Connie's boss has asked her to provide him a list of all customers who live in San Francisco, 

CA. To do this, Connie will create a ________. 

A) PDF 

B) form 

C) query 

D) question 

Answer:  C 

Diff: 2 

Ref:  Understanding Database Basics and Tables 
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26) A step-by-step guide that asks questions to help you decide what you want to do is called 

a(n) ________. 

A) wizard 

B) query 

C) design guide 

D) action guide 

Answer:  A 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

27) A recordset that is created at run time is called a(n) ________. 

A) question result 

B) query result 

C) search result 

D) answer result 

Answer:  B 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

28) A ________ is a table created at run time. 

A) form 

B) temporary table 

C) record set 

D) query result 

Answer:  C 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

29) An interface often used by end users of a database to enter and change data is called a(n) 

________. 

A) object 

B) table 

C) template 

D) form 

Answer:  D 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

30) A view that shows a form and the data is the ________ view. 

A) Print 

B) Design 

C) Layout 

D) Design 

Answer:  C 

Diff: 1 

Ref:  Understanding Database Basics and Tables 
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31) When you want to limit the amount of data that can be accessed by data entry clerks, you 

create a database ________ through which they can interact with the data they need to do their 

work. 

A) form 

B) table 

C) report 

D) object 

Answer:  A 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

 

32) An object that provides an easy-to-read format suitable for printing is a(n) ________. 

A) query 

B) report 

C) table 

D) form 

Answer:  B 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

33) A view that shows how a report will look on the printed page is the ________ view. 

A) design 

B) layout 

C) report 

D) print preview 

Answer:  D 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

34) ________ records arranges them together by the value of a single field. 

A) Gathering 

B) Grouping 

C) Joining 

D) Sorting 

Answer:  B 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

 

35) To put records within a group into a specific order based on the values of a specific field, you 

________ them. 

A) join 

B) group 

C) sort 

D) arrange 

Answer:  C 

Diff: 2 

Ref:  Understanding Database Basics and Tables 
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36) Your boss is concerned with losing data in the event of a natural disaster. To prevent data 

loss, you recommend to him that a ________ of the database should be made on a regular 

schedule. 

A) backup 

B) compaction 

C) substitute 

D) compression 

Answer:  A 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

 

37) Since Access does not reuse space when you delete a record, you need to occasionally 

________ the database to make more efficient use of space. 

A) compact 

B) group 

C) repair 

D) sort 

Answer:  A 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

38) Data is an important asset, because it permits businesses to make better decisions once it is 

converted into information. 

Answer:  TRUE 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

39) The two uses of databases are operational processing and future planning purposes. 

Answer:  FALSE 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

40) The four main objects in an Access database are tables., queries, forms, and reports. 

Answer:  TRUE 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

41) In an Access database, a column is a record, while a row is a field. 

Answer:  FALSE 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

42) A sample database is empty, while a template database has presupplied example data. 

Answer:  FALSE 

Diff: 2 

Ref:  Understanding Database Basics and Tables 
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43) Once you run a virus scan, you can trust a file permanently. 

Answer:  FALSE 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

44) To open or close the Navigation Pane, use the Shutter Bar Open/Close button. 

Answer:  TRUE 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

45) The ONLY view available in the Navigation Pane is all objects such as tables, queries, 

forms, and reports organized by object type. 

Answer:  FALSE 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

 

46) A database and a database management system are not the same thing. A database is a 

collection of data, while a database management system is a software program that manages the 

data. 

Answer:  TRUE 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

 

47) While it is possible to import data from an Excel file, it is NOT possible to import data from 

a Word file. 

Answer:  FALSE 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

 

48) When you name a table in Access, you should use a long name that specifically identifies the 

data in the table. 

Answer:  FALSE 

Diff: 3 

Ref:  Understanding Database Basics and Tables 

 

49) Breaking up a field such as address into multiple fields makes it easier to develop a report 

based on city or state. 

Answer:  TRUE 

Diff: 3 

Ref:  Understanding Database Basics and Tables 

 

50) Data redundancy occurs when you have tables that are not related to the other tables in the 

database. 

Answer:  FALSE 

Diff: 3 

Ref:  Understanding Database Basics and Tables 
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51) When you need to analyze the data in an Access database, you should export a query to 

Excel and use the analysis tools in Excel. 

Answer:  TRUE 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

52) Having multiple large tables open at once in Access can slow the database management 

system down. 

Answer:  TRUE 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

 

53) One of the limitations of the Access database management system is that it can NOT 

calculate information such as total sales or baseball scores. 

Answer:  FALSE 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

 

54) A query creates a run time table called a recordset. 

Answer:  TRUE 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

55) Access automatically saves data changes, so the query does not need to be saved. 

Answer:  FALSE 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

 

56) To prevent data entry clerks from having access to data that is not needed in their jobs, such 

as salaries or social security numbers of employees, a form can be developed that gives them 

only the access they need to complete their work. 

Answer:  TRUE 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

 

57) If you need to print your results, your BEST option is to create a query. 

Answer:  FALSE 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

 

58) Grouping records puts them within a specific ascending order based on field values. 

Answer:  FALSE 

Diff: 2 

Ref:  Understanding Database Basics and Tables 
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59) The Back Up Database command is available in the Backstage view on the Save & Publish 

tab. 

Answer:  TRUE 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

60) When you delete a record or object, Access reuses the original space for the next record or 

object you create. 

Answer:  FALSE 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

61) Facts about people, events, things, or ideas are called ________. 

Answer:  data 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

62) Storing, managing, and providing access to business records is the purpose of a(n) ________. 

Answer:  database 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

63) Linking ________ together is what makes databases powerful. 

Answer:  tables 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

64) Access is a(n) ________ DBMS (database management system). 

Answer:  relational 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

65) The data pertaining to one person, place, thing, or event is called a(n) ________. 

Answer:  record 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

66) The view that shows the data contents within a table is the ________ view. 

Answer:  datasheet 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

67) The view that shows how fields are defined is the ________ view. 

Answer:  design 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 



12 

Copyright © 2013 Pearson Education, Inc. 

68) A specific piece of information that is stored in every record in a column is called a(n) 

________. 

Answer:  field 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

69) While a sample database has sample data included with it, a(n) ________ is a database that 

has a structure and definitions, but no data. 

Answer:  template 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

 

70) You have to tell Access that you trust content before features that a(n) ________ might use 

to infect your computer will work. 

Answer:  virus 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

71) In Access, data is stored in an arrangement of columns and rows called ________. 

Answer:  tables 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

72) Copying data from another file in an Excel worksheet is called ________. 

Answer:  importing 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

73) Data ________ is the result of repetition of data in tables in a database. 

Answer:  redundancy 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

74) The way to find answers based on data in a database is to create a(n) ________. 

Answer:  query 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

75) A step-by-step guide that walks users through tasks to help you create a form, query, or 

report is a(n) ________. 

Answer:  wizard 

Diff: 1 

Ref:  Understanding Database Basics and Tables 
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76) A(n) ________ is the run time table created as the result of a query. 

Answer:  recordset 

Diff: 2 

Ref:  Understanding Database Basics and Tables 

 

77) The operator ________ selects the records where the field values listed are within the two 

values. 

Answer:  between 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

78) A way to interface with a table other than in the Datasheet view is a(n) ________. 

Answer:  form 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

79) A(n) ________ can be based on the data in a table or query. 

Answer:  report 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

 

80) Arranging records together by the value of a single field is called ________. 

Answer:  grouping 

Diff: 1 

Ref:  Understanding Database Basics and Tables 

81) Match the answer in the first column to the appropriate definition in the second column. 

Each answer can only be used once. 

I. < > 

II. = 

III. <= 

IV. >= 

V. < 

 

A. selects the records where the field value is greater than or equal to the value provided 

B. selects records where the field value is not equal to the value provided 

C. selects the records where the field value is less than or equal to the value provided 

D. selects the records where the field value is less than the value provided 

E. selects the records where the field value is equal to the value provided 

Answer:  I. B, II. E, III. C, IV. A, V. D 

Diff: 1 

Ref:  Understanding Queries, Forms, and Reports 
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82) Match the answer in the first column to the appropriate definition in the second column. 

Each answer can only be used once. 

I. append now 

II. recordset 

III. query design grid 

IV. compacting 

V. record selector 

 

A. a run time table created as the result of a query 

B. the first blank row at the end of the table 

C. a small box at the left of a record 

D. rearranging objects to use disk space more efficiently and releases the unused space that 

results from deleting records or objects 

E. the bottom half of the Design view screen which shows which fields are selected in a query 

Answer:  I. B, II. A, III. E, IV. D, V. C 

Diff: 1 

Ref:  Various 
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Your Office Microsoft 2010 Vol 1, 2e (Kinser) 

Microsoft Excel 2010, Workshop 1: Understanding and Manipulating Microsoft Excel 2010 

 

1) Microsoft's spreadsheet application is known as ________. 
A) Publisher 
B) Excel 
C) Access 
D) Outlook 
Answer:  B 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
 
2) Another word for a spreadsheet is ________. 
A) workbook 
B) field 
C) worksheet 
D) record 
Answer:  C 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
 
3) Which of the following statements is FALSE? 
A) Worksheets contain rows and columns. 
B) Worksheets contain workbooks. 
C) The number of worksheets that be contained in a workbook is a function of the amount of 
available memory. 
D) Another term for worksheets is spreadsheets. 
Answer:  B 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
4) Which of the following statements is FALSE? 
A) Excel 2010 workbooks have xls as their file extension. 
B) A spreadsheet is a powerful computer program. 
C) Spreadsheets are a grid of rows and columns. 
D) Spreadsheets are commonly used to perform what-if analysis. 
Answer:  A 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
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5) SUM and AVERAGE are examples of ________. 
A) formulas 
B) functions 
C) cell references 
D) records 
Answer:  B 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 

6) An equation that produces a result is known as a(n) ________. 
A) function 
B) record 
C) formula 
D) cell reference 
Answer:  C 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
7) All functions must begin with the ________ character. 
A) $ 
B) = 
C) > 
D) ? 
Answer:  B 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
 
8) Which of the following is least likely to be found in a single cell? 
A) operators 
B) text 
C) charts 
D) functions 
Answer:  C 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
 
9) Excel 2010 workbooks are saved with a default file extension of ________. 
A) .wbk 
B) .exc 
C) .accdb 
D) .xlsx 
Answer:  D 
Diff: 3 
Ref:  Understand spreadsheet terminology and components. 
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10) Which of the following statements about workbooks is TRUE? 
A) Workbooks must contain three worksheets. 
B) New, blank workbooks contain three worksheets, by default. 
C) There is a maximum of five worksheets in a workbook. 
D) Workbooks have a file extension of .xls. 
Answer:  B 
Diff: 3 
Ref:  Understand spreadsheet terminology and components. 

11) What-if analysis allows users to ________. 
A) create graphs and charts of existing data. 
B) insert built-in programs that perform tasks like SUM and AVERAGE. 
C) change values in spreadsheet cells to investigate the effects on calculated values of interest. 
D) create an equation that produces a result. 
Answer:  C 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
12) A user wishes to change values in a cell and see what the effects are on calculated values 
elsewhere in the worksheet. The user has executed a(n) ________. 
A) AutoFill 
B) what-if analysis 
C) formula 
D) function 
Answer:  B 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
13) A cell in the third row and fourth column has the cell reference ________. 
A) C4 
B) 3D 
C) 4C 
D) D3 
Answer:  D 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
14) Which of the following is not a valid cell reference? 
A) A3 
B) J21 
C) AA3 
D) 4C 
Answer:  D 
Diff: 3 
Ref:  Understand spreadsheet terminology and components. 
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15) Keyboard navigation can be done using ________ such as pressing the Tab key to move one 
column right. 
A) keyboard shortcuts 
B) magic keys 
C) active keys 
D) keyboard references 
Answer:  A 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 

16) Of the following, which makes up the smallest element in a workbook? 
A) cell 
B) row 
C) worksheet 
D) column 
Answer:  A 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
17) A ________ is labeled with a number, such as 1, 2, or 3. 
A) column 
B) row 
C) cell 
D) worksheet 
Answer:  B 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
18) A ________ is labeled with letters, such as A, B, or C. 
A) column 
B) row 
C) worksheet 
D) cell 
Answer:  A 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
19) Sheet1 is an example of a default ________ within a workbook. 
A) worksheet 
B) row 
C) cell 
D) column 
Answer:  A 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
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20) A ________ is found at an intersection in Excel, and might have a name such as C8 or G11. 
A) column 
B) row 
C) worksheet 
D) cell 
Answer:  C 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 

21) A worksheet contains all of the following EXCEPT ________. 
A) columns 
B) rows 
C) worksheets 
D) cells 
Answer:  C 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
22) Worksheet navigation is defined as moving the location of the active ________. 
A) column 
B) cell 
C) row 
D) worksheet 
Answer:  B 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
23) Printable characters, including letters, numbers, and special characters, are stored as 
________ data. 
A) text 
B) date/time 
C) numeric 
D) none of the above 
Answer:  A 
Diff: 1 
Ref:  Enter and edit data. 
 
24) Text that is too lengthy to fit in one cell can have text wrapping applied, or the user can add a 
________ to break up the data inside a cell. 
A) date/time 
B) range 
C) section break 
D) hard return 
Answer:  D 
Diff: 2 
Ref:  Enter and edit data. 
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25) A worksheet that is not currently visible can be changed to the ________ worksheet by 
clicking on the worksheet tab in the bottom-left corner of the Excel window. 
A) default 
B) referenced 
C) dormant 
D) active 
Answer:  D 
Diff: 2 
Ref:  Enter and edit data. 

26) A group of selected cells is also known as a cell ________. 
A) cluster 
B) range 
C) block 
D) field 
Answer:  B 
Diff: 1 
Ref:  Manipulate cells and cell ranges. 
 
27) Which of the following represents a cell range? 
A) C6-E10 
B) $B$6 
C) A4 + D14 
D) N8:P9 
Answer:  D 
Diff: 2 
Ref:  Manipulate cells and cell ranges. 
 
28) R4:T8 is an example of a ________. 
A) row 
B) column 
C) cell reference 
D) cell range 
Answer:  D 
Diff: 2 
Ref:  Manipulate cells and cell ranges. 
 
29) Which of the following statements is FALSE? 
A) Scaling can fit all columns on a single page. 
B) Scaling may make data too small to be readable. 
C) A worksheet in landscape orientation may be 11 inches wide by 8.5 inches tall. 
D) Portrait orientation means a page is wider than it is tall. 
Answer:  D 
Diff: 2 
Ref:  Manipulate cells and cell ranges. 
 



7 

Copyright © 2013 Pearson Education, Inc. 

30) AutoFill allows users to ________ using the fill handle. 
A) delete formulas from within cells 
B) move content from one cell to another 
C) copy information to the office clipboard to paste in to another worksheet 
D) copy information from one cell, or a series of cells, in to another set of cells 
Answer:  D 
Diff: 3 
Ref:  Manipulate cells and cell ranges. 

31) Which of the following is FALSE? 
A) White space is always white. 
B) White space gives a document visual structure. 
C) White space is a term for the part of the document that does not contain data or 
documentation. 
D) White space creates a sense of order in the mind of the worksheet user. 
Answer:  A 
Diff: 3 
Ref:  Manipulate cells and cell ranges. 
 
32) In order to see what a worksheet will look like when printed, use the Print ________ feature. 
A) Preview 
B) Range 
C) White Space 
D) Setup 
Answer:  A 
Diff: 1 
Ref:  Preview and print worksheets. 
 
33) Which of the following is an example of portrait dimensions? 
A) 8.5 inches wide by 11 inches tall 
B) 11 inches wide by 8.5 inches tall 
C) 5 inches wide by 5 inches tall 
D) All are examples of portrait dimensions. 
Answer:  A 
Diff: 2 
Ref:  Preview and print worksheets. 
 
34) A worksheet is a spreadsheet contained in a workbook. 
Answer:  TRUE 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
35) A worksheet is made up of rows and columns. 
Answer:  TRUE 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
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36) A workbook must contain at least three worksheets. 
Answer:  FALSE 
Diff: 3 
Ref:  Understand spreadsheet terminology and components. 
 
37) A spreadsheet is a computer program. 
Answer:  TRUE 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
 
38) The intersection of a row and column is called a cell. 
Answer:  TRUE 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 

39) Cells can contain text, numbers, formulas, and/or functions. 
Answer:  TRUE 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
 
40) Excel includes common functions such as SUM and AVERAGE. 
Answer:  TRUE 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
41) A formula is a built-in program that performs common tasks. 
Answer:  FALSE 
Diff: 3 
Ref:  Understand spreadsheet terminology and components. 
 
42) All formulas and functions must start with the equal sign (=). 
Answer:  TRUE 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
43) Changing values in spreadsheet cells to investigate the effects is known as what-if analysis. 
Answer:  TRUE 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
 
44) A column can also be referred to as a record. 
Answer:  TRUE 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
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45) A cell can also be referred to as a field. 
Answer:  TRUE 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
46) The intersection of a row and column is known as a record. 
Answer:  FALSE 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
47) There are more rows in an Excel spreadsheet than there are cells. 
Answer:  FALSE 
Diff: 3 
Ref:  Understand spreadsheet terminology and components. 
 
48) A new Excel workbook contains three worksheets, by default named Book1, Book2, and 
Book3. 
Answer:  FALSE 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 

49) Columns are lettered in descending sequence from left to right. 
Answer:  FALSE 
Diff: 3 
Ref:  Understand spreadsheet terminology and components. 
 
50) Rows are numbered in ascending sequence from top to bottom. 
Answer:  TRUE 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
51) The intersection of row 1 and column Q is known as 1Q, 
Answer:  FALSE 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
 
52) J42 is an example of a cell reference. 
Answer:  TRUE 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
 
53) Rows are represented by letters. 
Answer:  FALSE 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
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54) A cell can be made an active cell by clicking on it. 
Answer:  TRUE 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
 
55) Worksheet navigation refers to scrolling up and down (or left and right) in a worksheet using 
the scroll bar. 
Answer:  FALSE 
Diff: 3 
Ref:  Understand spreadsheet terminology and components. 
 
56) Scrolling in a worksheet moves the active cell. 
Answer:  FALSE 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
57) Changing the cell alignment so words fit on to multiple lines is also known as wrapping text. 
Answer:  TRUE 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
58) C6 is an example of a cell range. 
Answer:  FALSE 
Diff: 2 
Ref:  Enter and edit data. 

59) If the background of a worksheet is yellow, the area without data or documentation is 
referred to as yellow space rather than white space. 
Answer:  FALSE 
Diff: 2 
Ref:  Manipulate cells and cell ranges. 
 
60) Page breaks can NOT be inserted into an Excel worksheet. 
Answer:  FALSE 
Diff: 2 
Ref:  Preview and print worksheets. 
 
61) Portrait orientation means the page is taller than it is wide. 
Answer:  TRUE 
Diff: 2 
Ref:  Preview and print worksheets. 
 
62) Printouts are generally sent to square sheets of paper. 
Answer:  FALSE 
Diff: 1 
Ref:  Preview and print worksheets. 
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63) If data is too wide to fit on a printed page, scaling may solve the problem. 
Answer:  TRUE 
Diff: 2 
Ref:  Preview and print worksheets. 
 
64) Worksheets can be hidden from view. 
Answer:  TRUE 
Diff: 3 
Ref:  Manipulate worksheets and workbooks. 
 
65) Worksheets can be renamed, deleted, and moved. 
Answer:  TRUE 
Diff: 3 
Ref:  Manipulate worksheets and workbooks. 
 
66) Unused worksheets are a form of clutter in a workbook and generally should be deleted. 
Answer:  TRUE 
Diff: 3 
Ref:  Manipulate worksheets and workbooks. 
 
67) Worksheet footers appear at the top of the page. 
Answer:  FALSE 
Diff: 1 
Ref:  Manipulate worksheets and workbooks. 
 
68) Pressing Alt+Tab allows a user to quickly move between open workbooks. 
Answer:  FALSE 
Diff: 2 
Ref:  Manipulate worksheets and workbooks. 

69) A(n) ________ is another word for a spreadsheet. 
Answer:  worksheet 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
70) A(n) ________ is a powerful computer program with a user interface that is a grid of rows 
and columns. 
Answer:  spreadsheet 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
 
71) A(n) ________ is an intersection of a row and column. 
Answer:  cell 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
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72) Each worksheet contains a number of ________, each of which can contain text, numbers, 
formulas, and/or functions. 
Answer:  cells 
Diff: 3 
Ref:  Understand spreadsheet terminology and components. 
 
73) A(n) ________ is an equation that produces a result and may contain numbers, text, and 
other such data. 
Answer:  formula 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
74) Spreadsheets are used to perform ________, where you can change values in spreadsheet 
cells to investigate the effect on calculated values of interest. 
Answer:  what-if analysis 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
75) A spreadsheet can be used as a basic collection of data where each row is a(n) ________. 
Answer:  record 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
76) A spreadsheet can be used as a basic collection of data where each column is a(n) ________. 
Answer:  field 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
77) A cell in the second row and fifth column would be referred to by the cell reference 
________. 
Answer:  E2 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 

78) The intersection of column F and row 5 has the cell reference ________. 
Answer:  F5 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
 
79) A3 and E9 are examples of cell ________. 
Answer:  references 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
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80) ________ are lettered in ascending sequence from left to right. 
Answer:  Columns 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
 
81) The selected cell (with a thick, black line border) is also known as the ________ cell. 
Answer:  active 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
82) Moving the location of the current cell is known as worksheet ________. 
Answer:  navigation 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
 
83) By clicking on a worksheet tab, a user makes it the ________ worksheet. 
Answer:  active 
Diff: 1 
Ref:  Understand spreadsheet terminology and components. 
 
84) A set of selected cells that are not next to each other are also known as ________. 
Answer:  noncontiguous 
Diff: 3 
Ref:  Manipulate cells and cell ranges. 
 
85) A set of cells is also known as a cell ________. 
Answer:  range 
Diff: 2 
Ref:  Manipulate cells and cell ranges. 
 
86) A4:B5 is an example of a cell ________. 
Answer:  range 
Diff: 2 
Ref:  Manipulate cells and cell ranges. 
 
87) The part of a document that does not contain data is known as ________. 
Answer:  white space 
Diff: 1 
Ref:  Manipulate cells and cell ranges. 

88) If a user inserts a few blank rows around some data to create a sense of order, they have 
inserted ________. 
Answer:  white space 
Diff: 3 
Ref:  Manipulate cells and cell ranges. 
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89) In order to see a facsimile of how a document will look on paper, use the ________ option 
found under the File tab. 
Answer:  Print Preview 
Diff: 2 
Ref:  Manipulate cells and cell ranges. 
 
90) A that is page wider than it is tall is in ________ orientation. 
Answer:  landscape 
Diff: 2 
Ref:  Preview and print worksheets. 
 
91) A worksheet that is 11 inches tall and 8.5 inches wide is in ________ orientation. 
Answer:  portrait 
Diff: 3 
Ref:  Preview and print worksheets. 
 
92) Shrinking data to fit on one page is known as ________. 
Answer:  scaling 
Diff: 3 
Ref:  Manipulate cells and cell ranges. 
 
93) The white space left at the edges of the printed page are known as page ________. 
Answer:  margins 
Diff: 3 
Ref:  Manipulate cells and cell ranges. 
 
94) Match the answer in the first column to the appropriate definition in the second column. 
Each answer can only be used once. 
I. cell 
II. field 
III. formula 
IV. record 
V. range 
 
A. a row in a spreadsheet 
B. a column in a spreadsheet 
C. an intersection of a row and column 
D. a group of cells 
E. an equation that produces a result 
Answer:  I. C, II. B, III. E, IV. A, V. D 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
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95) Match the answer in the first column to the appropriate definition in the second column. 
Each answer can only be used once. 
I. cell 
II. column 
III. formula 
IV. range 
V. row 
 
A. K 
B. 12 
C. G4 
D. P4:R6 
E. =T3+T5 
Answer:  I. C, II. A, III. E, IV. D, V. B 
Diff: 2 
Ref:  Understand spreadsheet terminology and components. 
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Your Office Microsoft 2010 Vol 1, 2e (Kinser) 

Microsoft Office Outlook 2010, Workshop 1: Communicating with E-mail, and Managing 

Contacts, Calendars, and Tasks 

 

1) Each of the four major components of Outlook contains a ________ and toolbars. 

A) Contact card 

B) Default button 

C) task log 

D) Ribbon 

Answer:  D 

Diff: 1 

Ref:  Identifying the Components of the Outlook Window 

 

2) One advantage to sending e-mail is that e-mails are ________. 

A) more private and less likely to be shared 

B) slower than snail mail 

C) open to anyone who has a Web browser 

D) delivered almost instantly anywhere in the world via the Internet 

Answer:  D 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

3) A(n) ________ allows you to compose, send, and receive e-mail messages. 

A) host server 

B) mail client 

C) e-mail server 

D) message server 

Answer:  B 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

4) Mail sent through the U.S Postal Service is sometimes called ________. 

A) postcards 

B) letters 

C) snail mail 

D) paper mail 

Answer:  C 

Diff: 1 

Ref:  Describing the Basics of E-mail 
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5) A special computer that servers as a post office and enables you to receive your e-mails and 

delivers the messages you send is called a(n) ________. 

A) mail server 

B) e-mail server 

C) message server 

D) host server 

Answer:  A 

Diff: 1 

Ref:  Describing the Basics of E-mail 

6) A unique word that identifies you to the mail server is your ________. 

A) code name 

B) user name 

C) password 

D) identification name 

Answer:  B 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

7) A group of characters that works in combination with your user name to prevent unauthorized 

access by others is called a(n) ________. 

A) password 

B) user name 

C) identifier 

D) code name 

Answer:  A 

Diff: 2 

Ref:  Describing the Basics of E-mail 

 

8) The component of Outlook that contains panes, folders, and tools for managing e-mail is 

called the ________ component. 

A) contacts 

B) e-mail 

C) task 

D) calendar 

Answer:  B 

Diff: 1 

Ref:  Describing the Basics of E-mail 
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9) The pane that displays the text of a selected message, appointment, contact, or task is called 

the ________ Pane. 

A) Task 

B) Navigation 

C) E-mail 

D) Reading 

Answer:  D 

Diff: 2 

Ref:  Describing the Basics of E-mail 

 

10) Until deleted messages are permanently deleted, they are stored in the ________ folder. 

A) Junk E-mail 

B) Inbox 

C) Deleted Items 

D) Outbox 

Answer:  C 

Diff: 1 

Ref:  Describing the Basics of E-mail 

11) Messages you have written that have not yet been sent are kept in the ________ folder. 

A) Outbox 

B) Inbox 

C) Junk E-mail 

D) Deleted Items 

Answer:  A 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

12) The ________ folder keeps a copy of all the e-mails you send. 

A) Drafts 

B) Sent Items 

C) Outbox 

D) Deleted Items 

Answer:  B 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

13) Unfinished messages are saved in the ________ folder. 

A) Outbox 

B) Drafts 

C) Inbox 

D) Deleted Items 

Answer:  B 

Diff: 1 

Ref:  Describing the Basics of E-mail 
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14) To compose a new e-mail, click ________. 

A) Compose E-mail on the Home tab 

B) New E-mail on the Home tab 

C) Compose E-mail on the New tab 

D) New E-mail on the Insert tab 

Answer:  B 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

15) Outlook provides the option to use ________ which has preset colors, fonts, and effects. 

A) a theme 

B) WordArt 

C) stationery 

D) SmartArt 

Answer:  C 

Diff: 2 

Ref:  Describing the Basics of E-mail 

16) Options to add vivid colors, active graphics, and background images that are not available in 

stationery are available in ________. 

A) WordArt 

B) Art gallery 

C) themes 

D) SmartArt 

Answer:  C 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

17) The To box contains the ________ of the recipient. 

A) full names 

B) street addresses 

C) phone numbers 

D) e-mail addresses 

Answer:  D 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

18) The ________ text box contains the address of other people who will receive copies of the e-

mail. 

A) From 

B) Cdd 

C) To 

D) Cc 

Answer:  D 

Diff: 1 

Ref:  Describing the Basics of E-mail 
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19) If you need to document an e-mail by sending a copy to your supervisor without the main 

recipient knowing your supervisor is getting a copy, you would put your supervisor's e-mail 

address in the ________ box. 

A) To 

B) Bcc 

C) Cc 

D) Cdd 

Answer:  B 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

20) Mail servers may block e-mails with attached file types with ________ enabled. 

A) contents 

B) file names 

C) macros 

D) saving 

Answer:  C 

Diff: 2 

Ref:  Describing the Basics of E-mail 

21) When you reply to an e-mail, Outlook automatically enters the ________ to the appropriate 

boxes. 

A) signatures 

B) recipients 

C) themes 

D) files 

Answer:  B 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

22) The ________ button sends a message to everyone in the To and Cc text boxes. 

A) Forward 

B) Send 

C) Reply All 

D) Reply 

Answer:  C 

Diff: 1 

Ref:  Describing the Basics of E-mail 
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23) When you receive a message, you can ________ it to someone who did not originally 

receive it. 

A) Reply 

B) Forward 

C) Mail 

D) Send 

Answer:  B 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

24) The shortcut key method to begin a New E-mail, Appointment, or Task is ________, 

depending on which component you are currently displaying. 

A) N 

B) Ctrl+N 

C) Shift+N 

D) Alt+N 

Answer:  B 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

25) Your supervisor, Joan, has sent you a very important e-mail message. To the right of the 

message in the Inbox, this message will display a(n) ________. 

A) asterisk 

B) exclamation point 

C) paper clip 

D) flag 

Answer:  B 

Diff: 1 

Ref:  Describing the Basics of E-mail 

26) In Outlook, you can use ________ to help you organize your work by grouping together 

similar items and assigning a group name and color. 

A) flags 

B) graphics 

C) colors 

D) Categories 

Answer:  D 

Diff: 1 

Ref:  Describing the Basics of E-mail 
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27) Messages that share the same subject line, and can be collapsed or expanded as needed are 

called ________. 

A) topics 

B) threads 

C) themes 

D) conversations 

Answer:  D 

Diff: 2 

Ref:  Describing the Basics of E-mail 

 

28) The style that provides a header to the message listing the person the message is from, when 

it was sent, who the recipients were, the Subject, and the file name of attachments is called the 

________. 

A) Memo Style 

B) Conversation Style 

C) E-mail Style 

D) Table Style 

Answer:  A 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

29) ________ messages is a good method to document a conversation. 

A) Saving 

B) Printing 

C) Forwarding 

D) Deleting 

Answer:  B 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

30) Keeping track of e-mail addresses is much easier when you use the ________ component of 

Outlook. 

A) Navigation 

B) Reading Pane 

C) Contacts 

D) Calendar 

Answer:  C 

Diff: 1 

Ref:  Creating and Using Contacts 
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31) When you set up a(n) ________, you can use the name of the list in the address box of new 

e-mail messages. 

A) distribution list 

B) contacts list 

C) group list 

D) activity list 

Answer:  A 

Diff: 2 

Ref:  Creating and Using Contacts 

 

32) You can organize your schedule and set up reminders using Outlook's ________ component. 

A) Task 

B) Contacts 

C) Calendar 

D) Mail 

Answer:  C 

Diff: 1 

Ref:  Managing the Calendar 

 

33) A small month calendar that is used to select different dates quickly is the ________. 

A) Daily Schedule 

B) To-Do Bar 

C) Work Calendar 

D) Date Navigator 

Answer:  D 

Diff: 2 

Ref:  Managing the Calendar 

 

34) A feature that provides a quick overview of the calendar, upcoming appointments, and tasks 

is the ________. 

A) To-Do Bar 

B) Date Navigator 

C) Notes Bar 

D) Daily Calendar 

Answer:  A 

Diff: 2 

Ref:  Managing the Calendar 

 

35) Using a rule, you can apply ________ to appointments on your calendar to help remind 

yourself that a meeting is important. 

A) exclamation points 

B) asterisks 

C) a graphic 

D) conditional formatting 

Answer:  D 

Diff: 3 

Ref:  Managing the Calendar 
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36) Activities on the Outlook ________ list can be scheduled, categorized, marked as complete, 

or assigned to other people. 

A) Tasks 

B) Schedule 

C) Calendar 

D) Contacts 

Answer:  A 

Diff: 2 

Ref:  Managing Tasks and Notes 

 

37) Tasks appear on the ________ List in the main window of the Tasks component. 

A) To_Do 

B) Notes 

C) Schedule 

D) Contacts 

Answer:  A 

Diff: 1 

Ref:  Managing Tasks and Notes 

 

38) To create a new note, click the Notes button on the Navigation Pane and then click 

________. 

A) New Note on the Home tab 

B) New Note on the Insert tab 

C) Create Note on the Insert tab 

D) Create Note on the Home tab 

Answer:  A 

Diff: 2 

Ref:  Managing Tasks and Notes 

 

39) Each Outlook component contains a Ribbon and toolbars that provide access to commands. 

Answer:  TRUE 

Diff: 1 

Ref:  Identifying the Components of the Outlook Window 

 

40) An advantage of e-mail over snail mail is the ability to instantly send and receive messages 

anywhere in the world via the Internet. 

Answer:  TRUE 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

41) Microsoft Outlook is an example of a mail client. 

Answer:  TRUE 

Diff: 1 

Ref:  Describing the Basics of E-mail 
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42) A good password is any unusual word found in a dictionary. 

Answer:  FALSE 

Diff: 1 

Ref:  Describing the Basics of E-mail 

43) By default, when you log on to the mail server, outgoing mail is uploaded from your 

computer to the server and sent to the recipient(s), and your new mail is downloaded into the 

Outlook Inbox folder of your computer. 

Answer:  TRUE 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

44) It is illegal for employers to monitor employee e-mail sent using the company e-mail system. 

Answer:  FALSE 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

45) The Reading Pane allows you to see the text of a selected message, appointment, contact, or 

task depending on the selected component. 

Answer:  TRUE 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

46) When you delete a message from the Inbox, it has been permanently removed from your 

computer. 

Answer:  FALSE 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

47) Outlook's junk e-mail system is infallible and never makes a mistake, so you do not need to 

review the Junk E-mail folder for legitimate messages. 

Answer:  FALSE 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

48) When you send a message, you must manually move a copy of the message to the Sent Items 

folder. 

Answer:  FALSE 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

49) Themes and stationery can be used to add preset colors, fonts, effects, active graphics, and 

background images to your e-mail. 

Answer:  TRUE 

Diff: 1 

Ref:  Describing the Basics of E-mail 
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50) Using the Cc address box will hide the e-mail addresses of multiple recipients from each 

other. 

Answer:  FALSE 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

51) Before sending an e-mail, you should double-check the addresses entered into the address 

boxes to ensure they are accurate. 

Answer:  TRUE 

Diff: 1 

Ref:  Describing the Basics of E-mail 

52) Since mail servers seldom have a size limit on them, you can send an e-mail with a large file 

attached without being concerned that your recipient will receive it. 

Answer:  FALSE 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

53) A signature block contains text and sometimes graphics that provide additional information 

about the sender. 

Answer:  TRUE 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

54) The speed at which an e-mail is conveyed and delivered is based on factors such as 

connection speed, size of attachments, and network traffic. 

Answer:  TRUE 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

55) Messages in the Inbox which have been read will appear in BOLD type. 

Answer:  FALSE 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

56) You CAN categorize e-mail, calendar items, and contacts with color coding, but you 

CANNOT categorize tasks with color coding. 

Answer:  FALSE 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

57) Conversations, messages that can be viewed in groups, can be expanded or collapsed. 

Answer:  TRUE 

Diff: 1 

Ref:  Describing the Basics of E-mail 
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58) Outlook is a desktop assistant that allows you to dynamically share information between the 

components by dragging it from one component to another. 

Answer:  TRUE 

Diff: 2 

Ref:  Organizing Your Life with Contacts, Calendars, Tasks, and Notes 

 

59) The Contacts component in Outlook keeps track of addresses and other personal information. 

Answer:  TRUE 

Diff: 1 

Ref:  Organizing Your Life with Contacts, Calendars, Tasks, and Notes 

 

60) You can print the entire contact list, but it is NOT possible to print a single contact card. 

Answer:  FALSE 

Diff: 1 

Ref:  Creating and Using Contacts 

61) In Outlook you can have a work calendar, a personal calendar, and a school calendar, and 

view them all at the same time. 

Answer:  TRUE 

Diff: 3 

Ref:  Managing the Calendar 

 

62) Notes, similar to sticky notes, are available as an Add-in component to Outlook. 

Answer:  FALSE 

Diff: 3 

Ref:  Managing Tasks and Notes 

 

63) The buttons for each major component of Outlook are available at the bottom of the 

________. 

Answer:  Navigation pane 

Diff: 2 

Ref:  Introduction to Outlook and E-mail 

 

64) E-mail is the short version of the phrase ________. 

Answer:  electronic mail 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

65) A(n) ________ allows you to compose, send and receive e-mail messages, while a mail 

server functions as the post office and ensures you can send and receive messages. 

Answer:  mail client 

Diff: 1 

Ref:  Describing the Basics of E-mail 
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66) A(n) ________ is a unique word that identifies you to the mail server. 

Answer:  user name 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

67) A secret word or group of characters that work in combination with your user name to 

protect your account from unauthorized access is called a(n) ________. 

Answer:  password 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

68) When you receive new mail, by default, it goes into the Outlook ________ folder on your 

computer. 

Answer:  Inbox 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

69) If you turn off the ________, you can open a message in a new window by double-clicking 

the message in the message list. 

Answer:  Reading Pane 

Diff: 2 

Ref:  Describing the Basics of E-mail 

70) When you delete messages from the Inbox, they are stored in the ________ folder until you 

permanently delete them. 

Answer:  Deleted Items 

Diff: 2 

Ref:  Describing the Basics of E-mail 

 

71) The ________ folder holds all the messages you have written that have NOT been uploaded 

to the server. 

Answer:  Outbox 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

72) By default, received messages are arranged by ________ and time, with the most recent 

messages on top of the list. 

Answer:  date 

Diff: 1 

Ref:  Describing the Basics of E-mail 

 

73) ________ can be expanded or collapsed as needed and share the same subject line. 

Answer:  Conversations 

Diff: 2 

Ref:  Describing the Basics of E-mail 

 



14 

Copyright © 2013 Pearson Education, Inc. 

74) The ________ component of Outlook allows you to store personal information, notes, and a 

photograph of the person on the card. 

Answer:  Contacts 

Diff: 2 

Ref:  Organizing Your Life with Contacts, Calendars, Tasks, and Notes 

 

75) In the Contacts component, the ________ view allows you to see the information you 

entered into fields as you created the contact. 

Answer:  Card 

Diff: 2 

Ref:  Creating and Using Contacts 

 

76) When you print the contacts in a category using the ________, the contact card information 

for each contact will print on separate sheets. 

Answer:  Memo Style 

Diff: 3 

Ref:  Creating and Using Contacts 

 

77) Contact ________ allow you to quickly send an e-mail to a predefined list of people. 

Answer:  groups 

Diff: 1 

Ref:  Creating and Using Contacts 

 

78) The ________ component of Outlook lets you set up appointments, reminders, and organize 

your schedule. 

Answer:  Calendar 

Diff: 1 

Ref:  Managing the Calendar 

79) The Calendar folders are displayed on the left of the ________ of the Outlook window. 

Answer:  Navigation Pane 

Diff: 2 

Ref:  Managing the Calendar 

 

80) A small month calendar that allows you to select specific dates quickly is the ________. 

Answer:  Date Navigator 

Diff: 2 

Ref:  Managing the Calendar 

 

81) For a quick overview of the calendar, upcoming appointments, and tasks, you should review 

the ________. 

Answer:  To-Do Bar 

Diff: 1 

Ref:  Managing the Calendar 
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82) A(n) ________ is an assignment of time for which you do not have to schedule resources 

such as rooms. 

Answer:  appointment 

Diff: 1 

Ref:  Managing the Calendar 

 

83) When Outlook automatically creates and sends e-mail notifications to one or more scheduled 

attendees, you have scheduled a(n) ________. 

Answer:  meeting 

Diff: 2 

Ref:  Managing the Calendar 

 

84) When you place ________ in folders, they will be shown on the main To-Do List. 

Answer:  tasks 

Diff: 1 

Ref:  Managing Tasks and Notes 

 

85) When a task is displayed with red text, it indicates that the task is ________. 

Answer:  overdue 

Diff: 1 

Ref:  Managing Tasks and Notes 

 

86) The purpose of the ________ component is to jog your memory rather than to set a deadline. 

Answer:  Notes 

Diff: 1 

Ref:  Managing Tasks and Notes 
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